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1. Introduction
(This brief  introduction should be read fully because it will give you the best approach to getting you familiar with the application quickly.)
As a group we decided to work on a simulation of the MIPS 5-stage pipeline. Our goal is to provide a graphical interface that would allow professors and/or students to simulate the cycles and stages in which assembly language instructions are executed. 
Our code will run for up to 30 cycles.

All of our work was programmed using QT. We have used the commercial free 30 days trial version to develop our work. 

You may also download the Open Source QT, but you may run the risk of not being able to build or run the application. We strongly recommend using the commercial version for QT for a start.

Note that our simulation does not take into account the content of registers so instructions jr , beq, and bne are handled based on the name of the register.

Documents Attached:  We have attached a zip (PipeliningDemo.zip) file containing the following:

1. main.cpp 

2. mainwindow.h

3. mainwindow.cpp

4. InstructionEditor.h

5. InstructionEditor.cpp

6. genericbutton.cpp

7. genericbutton.h

8. PipeliningTable.h

9. PipeliningTable.cpp

10. PipeliningDemo.pro

11. Folder PipeliningBIN
Quick and dirty run: Go to The folder PipeliningBIN and run the file PipeliningDemo.exe inside the folder before the 30 day trial agreement expires.
Enter your assembly instructions and then press the Start Pipeline and observe the pipeline table getting populated.

Each row is an assembly language instruction !

A sample assembly language program could be :

add 4 6 7

sub 3 4 8

lw 9 6(7)

sub 9 1 8

out 

mult 4 6 7

beq 4 4 out

You can check or uncheck any of the checkboxes and the press the ‘Start Pipeline’ button to see the corresponding effect. The color legends explain the data hazards technique  that are handled during a single run. 

The instructions that you enter are not case sensitive. For more details on instruction format go to the section “Input Format to Enter” of this document.

Note that a ‘Jr’ instructions will always exit the application because we are running a simulation and we don’t actually care about the content of the register.

However a ‘beq’ or ‘bneq’, rely on just the name on the instructions to determine whether or not a branch is taken or not.

For example the following instructions will lead to a taken branch

beq $4 $4 out   /   bneq $4 $5 out 
The following instructions will lead to an untaken branch

beq $4 $5 out   /   bneq $4 $4 out 

You may check multiple data hazard avoidance algorithms at the same time. However Branch Prediction and Delayed Branch cannot run simultaneously.

Note that our branch prediction assumes that the branch is not taken.
Our pipelining project handles most the instructions commands of assembly language.

The following is a list of the features that our simulator handles:

1. Basic Run Of Instructions without handling data hazards

2. Forwarding

3. Branch Prediction

4. Delayed Branch

5. Data Dependence Detection and Rearrangement of Instructions.
6. Handling wrongly formatted instructions
This document will first cover the basics of running the simulator, and then it will go into depth about the internal architecture of the program and explain the algorithms that were applied.

2. How to run and build PipeliningDemo

A. RUNNING  THE APPLICATION

A1.If you don’t have QT installed on your machine and want to simply run the demo

We have attached a folder called “PipeliningBIN”.

The folder PipeliningBIN contains all the dll necessary for an effective run.

If the executable Pipeliningdemo.exe is not in that folder, place it in that folder before executing it. The demo should run properly.

 If your operating system is windows XP or Vista and you get a message telling you that  “The application has failed to start because the side-by-side configuration is incorrect”.

You may want to download  “Visual Studio 2008 Express”  at http://www.microsoft.com/exPress/download/. The download procedure could take 30minutes to an hour and require you to restart your computer.
In case of  further difficulty please email  Sylvia N’guessan at olanys@yahoo.com
A2.If you  have QT installed on your machine and want to simply run the demo
If running the file Pipeliningdemo.exe from your desktop does not work because it is missing some ‘dll’, you may simply run the executable file in the ‘/qt/bin’ folder where you have installed QT. 

For example if you have installed QT in c:/2009.02/, your ‘bin’ directory is in 

c:/2009.02/qt/bin.

You may also try to add to your system path that ‘bin’ directory (for example add c:/2009.02/qt/bin  to your path).

B. BUILDING  THE APPLICATION
B1. Installing Comercial Version QT on Windows

0. You may want to download  “Visual Studio 2008 Express”  at http://www.microsoft.com/exPress/download/.

1. Go to  http://www.qtsoftware.com/downloads

2. Select Windows
3. Fill up your information + Check “Please send me QT-related information by email”

4. Within 15 minutes to 3 days you will receive 2 emails (the first one may be about info)   with a product  key in it. You need to save the email with subject line 'Qt evaluation email’.

5. In that email, copy the license key (located at the end of the email).
6a.Click on the link Qt SDK windows /Qt installation will begin and will take 10 to 15 minutes. Follow the installation steps.  Make sure QtCreator is checked.
6b.When download has completed, you may start QtCreator which is an environment in which you can develop using QT

B2. Building Pipelining Demo on QtCreator

There are 2 ways to build the project on QTcreator.

1. You may choose to open the PipelingDemo.pro file attached in QtCreator and then build the project.

2. You may also choose to create a new project on QT creator by going to  File > New > 

and selecting  QT4 Gui Application.

Once your project has been created you should then right click of the Project Link (in bold characters, (see picture below) ) and select ‘add existing files’ and add the following files to your project:

InstructionEditor.cpp, InstructionEditor.h, PipeliningTable.cpp, PipeliningTable.h

genericbutton.cpp, genericbutton.h, main.cpp

You may then build the project (by clicking on the green arrow).

The picture below illustrates the section above.

Don’t forget to right-click on the Project.
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Building or running the project will create a  .exe file that may be found in the debug or release folders located where your .pro file resides.
3. Input Format to enter 

The following instructions are handled:

Arithmetic operations: add, sub, mult, div, addu, subu, multu, divu, addi, and, or, nor, andi, ori, sll, srl, beq, bne, slt, sltu, stlti, sltiu, addi, andi, ori

Jump instructions: j, jr, jal

Data transfer: lhu, lh, lw, lbu,lui, sw, sb , sh, sc

Labels: must be a single word 
NB: The system will skip instructions that do not obey the proper format !!

Also, the instructions are not case sensitive.

The following are examples of good and bad formats:

Arithmetic Format->Making sure there are 3 elements after the instructions

Add 3 4 5                            // good format Register1 = 3  Register2 =  4 Register3= 5
Add $3 $4 $5                    // good format Register1 = $3  Register2 = $4 Register3= $5
Add $3 8  8                     // good format Register1 = $3  Register2 = 8 Register3= 8
Add Sylvia Luke H      // good format  Register1 = Sylvia Register2 = Luke  Register3=H
Beq $2 $2  exit           // good format Register1 = $2  Register2 = $2 
Beq $2 $2  exit          // good format Register1 = $2  Register2 = $2
Add $2 $2                // bad format
Transfer Format->Making sure there is no space after brackets !

lw 4 5(6)             //good format Register1=4  Constant=5 Register2=6
sw 4 3($6)          //good format Register1=4  Constant=3 Register2=$6
lw 3 4 6             // bad format
lw 3 4(  6  )       // bad format  due to spacing
Jump Format-> Making sure there is only elements after the instruction

Jr $5                  //good format
J exit                 //good format.
J  5 5                   // bad format
Label Format-> Making sure there is only one instruction

Loop:                  //good format
Out                     //good format.

Loop   out          // bad format
4. Graphical Architecture and Color Coding 

The following Picture Illustrates the graphical interface:
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Legend
1. Start Pipeline Button          9. Pipelining Table
2. ClearPipeline Button        10. Color Coding legen

3. Exit Application Button   11. Font slider

4. Forwarding CheckBox

5. Branch Prediction CheckBox

6. Delayed Branch CheckBox

7. Dependence Detection CheckBox

8. Forwarding CheckBox

9. Instruction Text Edit Box

1. Start Pipeline Button : Begins Pipelining process         
2. ClearPipeline Button :  Clears Pipelining Table       
3. Exit Application Button : Exits Pipelining Application Button 
4. Forwarding CheckBox:  Forwarding Enabling State
5. Branch Prediction CheckBox: Branch Prediction Enabling State .You may not have branch prediction and delayed branch at the same time.
6. Dependence Detection CheckBox:Data Dependence Detection Algorithm Enabling State.
7. Delayed BranchCheckBox: Forwarding Enabling State.
8. Instruction Text Edit Box: This is were assembly language editing is done.
9. Pipelining Table:  This is were pipeling output is executed. The row show the stages IF (instruction fetch stage ),ID (Instruction decoding stage) , EX (Instruction Execution stage) MEM (Memory stage) WB (write back stage)
10. Color Coding Legend:  Provides information about mechanism that are happening (forwarding, branch prediction etc…)
11. Font Size Slider:   It may happen that the you may see ‘…’ dots instead of the instruction name. Use the slider to adjust the size of your output.
Special Case of Data Dependence

The picture below illustrates a sample run of the following instructions with dependence detection. Observe that a text box will pop out showing how the instructions have been rearranged to reduce the cycle processing time.

The following is a set of instructions ran followed by the output on PipeliningDemo:

add 4 6 7

sub 3 4 8

lw 9 6(7)

sub 9 1 8

out 

mult 4 6 7

beq 4 4 out
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5. List of Data Structures and Methods and Instructions Supported

The following  is a logical organization of the methods and data structure used to process the code.

Data Structures:

QTableWidget *ptable;  
QString instr_abstract_table[100][7];
QString label_table[100][3];

QString Abstract_Pipelining_Table[5][100]; 

QColor Abstract_Pipelining_TableColor[5][100]; 
Methods For Graphical Operation Processing
void PopulateAbstractPipeliningTable(QString, int);

void ClearAbstractTable();
void StartAnimation();
void StopAnimation();    
void addcolumns(int); 
void add_instruction_to_table(int, int, QColor, QString);
void ClearTable();  

void SetNumberOfLines(int); 
void SetContentString(QTextDocument*);
void SignalAnimationStopped();
void SignalInvalidInstruction(int);

void UncheckPrediction(bool);

void UncheckDelayedBranch(bool);

void SignalDataDependence(QString);
void ShowRearrangedInstructions();

void RemoveRearrangedInstructions();
Methods checking format validity  of instructions:
bool isInstructionValid(QStringList*,int);                                                                           bool isInstructionFormatTransfer(QString);
bool isInstructionFormatArithm_Brch_Logic(QString);

bool isInstructionFormatArithm_Immediate_Logic(QString);   
bool isInstructionFormatUnconditionJump(QString);   
bool isInstructionFormatArithmLogic(QString);    
bool isInstructionFormatLoadTransfer(QString); 

bool isInstructionFormatStoreTransfer(QString); 

bool isInstructionFormatBranchLogic(QString); 

bool isInstructionFormatLUI(QString); 

Methods For Taken Branches Handling
int FindTakenBranch(QString);

void ProcessBranchOperations(QString, int, int);

Methods For Handling Instruction Position
bool BubbleVertical(QString,int);
bool HandleArithmeticOperations(QString, int, int);

bool HandleLoadOperations(QString, int, int);

bool HandleImmediateOperations(QString, int, int);

bool HandleBranchOperations(QString, int, int);

bool HandleJumpOperations(QString, int, int);

bool HandleLUIOperations(QString, int, int);

bool HandleJROperations(QString, int, int);
Methods For Code Processing
void processCode();

void processOperation(QString, int, int);
Methods For Setting Up Code Processing
void SetForwarding(int);

void SetBranchPrediction(int);

void SetDependence(int);

void SetDelayedBranch(int);

void UpdateFontSize(int);
Methods For Dependence Detection
bool HasDependence(int, int);

void SwapInstruction(int, int);

void RearrangeInstructions();

bool IsBlockInstruction(QString);

void Inserting(int, int);

int find_replacement(int, int);
List of Supported Instructiosn

Add

Sub

Mult 
Div

Addu

Subu

Multu

Divu

Addi

And

Or

Nor 
Andi

Ori

Sll

Srl

Beq

Bne

Sw

Sb 

sh

Slt

Sltu

sltui

Lw

Lh

lhu

lbu

lui

ll

sw

sb

sh

sc

jr

j

jal

6. Implemetation Details 

6.1 Graphical Interface
The main (main.cpp) document lays out the structure of the graphical interface.

We first define a window pane, a set of 3 buttons (Start Pipeline, Clear Table, and Exit Application ), a set of checkboxes (Forwarding, Branch Prediction, Delayed Branch and Data Dependence), an Instruction editor and a Pipelining Table.  We then put all those elements in a GridLayout that allows us to arrange the location at which we want them to appear.

Finally, by the QT mechanism of signals and slots, we link each graphical element to an signal event; that graphical element will respond with a slot method. 

For example:

QObject::connect(BranchPrediction, SIGNAL(stateChanged(int)), &pipeliningTable, SLOT(SetBranchPrediction(int)));
This example shows how we connect the checkbox Branch Prediction to  the PipeliningTable.  The method  SetBranchPrediction  will take as input the signal received  by the method StateChanged. Consequently the Branch prediction will be disabled if the checkbox is unchecked and will be enable if the checkbox is checked.

6.2 General Logic Flow

The center of our logic lays in the file PipeliningTable.cpp.

The ideas is that when the user presses The ‘Start Pipeline’ the following occurs:

Step 1: We Parse the instructions entered and store each instruction in the 2-D array called instr_abstract_table.  Each instructions is checked for their validity. 
The validity of each instruction is handled by the methods.

 bool isInstructionFormatTransfer(QString op);
bool isInstructionFormatArithm_Brch_Logic(QString op);

bool isInstructionFormatArithm_Immediate_Logic(QString op);   
bool isInstructionFormatUnconditionJump(QString op);   
bool isInstructionFormatArithmLogic(QString op);    
bool isInstructionFormatLoadTransfer(QString op ); 

bool isInstructionFormatStoreTransfer(QString op); 
bool isInstructionFormatBranchLogic(QString op);

An invalid instruction is highlighted in red. We do this by emitting a signal to the InstructionEditor telling it which line to highlight in red. The corresponding instruction is not added to instr_abstract_table.
For example parsing the instruction add $4 $5 $7 will end up with the following state:

instr_abstract_table[0][0] = “add”

instr_abstract_table[0][1] = $4

instr_abstract_table[0][2] = $5

instr_abstract_table[0][3] = $7

When we fall on a label instruction, we add it and its line number to the data structure label_table.

For example, if the label “Exit” is on line 6  we get 

instr_abstract_table[0][0] = “Exit”

instr_abstract_table[0][1] = “N/A”

instr_abstract_table[0][2] = “N/A”

instr_abstract_table[0][3] = “N/A”

label_table[0][0] = “Exit”

label_table[0][1] = 6

 Step 2: Once we have populated the instr_abstract_table and label_table  table,

We are ready to enter all our instructions in the Abstract_Pipelining_Table.

The Abstract_Pipelining_Table is an abstract table  equivalent  table to the one that the user sees ptable.

In other words, what we do is populate the abstract table (this is done by  the method processCode() which first parses all thevalid instructions then  calls PopulateAbstractTable().
PopulateAbstractTable() will in turn call processOperation() for each stage of the pipeline (IF,ID,EX, MEM and WB)

We get the maximum column size of the table (maxCycle) after we have processed every instructions. That value tells us how many columns ptable should have. Then last we go column by column and  animate it graphically on the ptable.

The Abstract_Pipelining_TableColor is the exact same size of the Abstract_Pipelining_Table table, it contains the color coding of each instructions.

All the blocks of this color table are initialized to the color blue.

Depending on whether forwarding, dependence detection, delayed branch , branch prediction is implemented, the color in the corresponding block of the   Abstract_Pipelining_TableColor  will change accordingly.

6.3 Animation

What the users sees when the animation is happening is the content of the abstract table graphically represented via ptable.
When defining the constructor method for the  PipeliningTableClass  we initialize the timer  with a rate of 200ms as follows:

    //initializing timer with default Timing Rate

    frameRate = 200;

    StageProcessed = false;

    timer.start(frameRate, this);
The implementation of the timer is found in the method PipeliningTable::timerEvent(QTimerEvent *event).  The method PipeliningTable::paintEvent(QPaintEvent *  event) repaints  the screen whenever the timer is triggered.
You can observe from theter method that we project the content of Abstract_Pipelining_Table  to ptable. The color coding is determined by the content of the data structure Abstract_Pipelining_TableColor.  
6.4 Arithmetic Operations

1. Without any Hazard Detection
Arithmetic operations are process by the methods HandleArithmeticOperations(QString op, int row, int instructionIndex)  and HandleImmediateOperations(QString op, int row, int instructionIndex)..

This intructions will populate the Abstract_Pipelining_Table  in a diagonal fashion unless if there is already an instruction in the block of table at which they want to populate.

If that is the case we call the method BubbleVertical() that will stall the instruction until the next cycle and until if finds a block that is not already populated by another instruction.

If the row corresponds to the EX stage and the block is available, we check for the previous instruction.

2. If the previous instruction is an arithmetic operation

We check that the result of the previous is used as operand of the current instructions.  If that is the case, the stall the current instruction for one cycle at the ID Stage.
3. If the previous instruction is a memory transfer operation (lw, lui, sw)

We check that the result of the previous is used as operand of the current instructions. If that is the case, the stall the current instruction for two cycle at the ID stage.
4. If the previous instruction is a branch operation (bne, beq) that is taken

We process the operation diagonally but flush it by indicating it in orange in the Abstract_Pipelining_TableColor  at the ID, EX, MEM and WB stages.
6.5 Transfer Operations

1. Without any Hazard Detection
Arithmetic operations are process by the method HandleLoadOperations(QString op, int row, int instructionIndex).

This intructions will populate the Abstract_Pipelining_Table  in a diagonal fashion unless if there is already an instruction in the block of table at which they want to populate.

If that is the case we call the method BubbleVertical() that will stall the instruction until the next cycle and until if finds a block that is not already populated by another instruction.

If the row corresponds to the EX stage and the block is available, we check for the previous instruction.

2. If the previous instruction is an arithmetic operation

We check that the result of the previous is used as operand of the current instructions.  If that is the case, the stall the current instruction for one cycle at the ID Stage.
3. If the previous instruction is a memory transfer operation (lw, lui, sw)

We check that the result of the previous is used as operand of the current instructions. If that is the case, the stall the current instruction for two cycle at the ID stage.
4. If the previous instruction is a branch operation (bne, beq) that is taken

We process the operation diagonally but flush it by indicating it in orange in the Abstract_Pipelining_TableColor  at the ID, EX, MEM and WB stages.
6.6 Branch Operations

1. Without any Hazard Detection
Arithmetic operations are process by the method HandleBranchOperations(QString op, int row, int instructionIndex).

This intruction will populate the Abstract_Pipelining_Table  in a diagonal fashion unless if there is already an instruction in the block of table at which they want to populate.

If that is the case we call the method BubbleVertical() that will stall the instruction until the next cycle and until if finds a block that is not already populated by another instruction.

If the row corresponds to the ID stage and the block is available, we check for the previous instruction.

2. If the previous instruction is an arithmetic operation

We check that the result of the previous is used as operand of the current instructions.  If that is the case, the stall the current instruction for 2 cycles at the ID Stage.
3. If the previous instruction is a memory transfer operation (lw, lui, sw)

We check that the result of the previous is used as operand of the current instructions. If that is the case, the stall the current instruction for 3 cycles at the ID stage.
4. If the previous instruction is a branch operation (bne, beq) that is taken

We process the operation diagonally but flush it by indicating it in orange in the Abstract_Pipelining_TableColor  at the ID, EX, MEM and WB stages.
The branch operations get the label at which they have to jump by searching for the instruction index in the label_table  that was populated when the instructions were being parsed.
6.7 Jump Operations

These instructions will populate the Abstract_Pipelining_Table  in a diagonal fashion unless  there is already an instruction in the block of table at which they want to populate. If that is the case we call the method BubbleVertical() that will stall the instruction until the next cycle and until if finds a block that is not already populated by another instruction.

The methods HandleJumpOperations(QString, int, int) and HandleJROperations(QString, int, int)  handle the jump instructions.

They get the label at which they have to jump by searching for the instruction index  in the label_table  The ‘jr’ was written so as to always exist the code.

6.8 Forwarding (implemented in methods HandleArithmeticOperations, HandleImmediateOperations, HandleJROperations, HandleLuiOperations, HandleBranchOperations, HandleLoadOperations etc..)

We represent forwarded instruction in yellow.

Whenever forwarding has been enabled any instruction that stalled for x cycles without forwading will stall for x-1 cycles with forwarding.

For example, if the previous instruction before and arithmetic instruction is a transfer instruction (lw, lui etc..), in absence of forwarding we stall the operation at the ID stage for 2 cycles. With forwarding enabled we stall the operation for 1 cycle.

In the Abstract_Pipelining_TableColor, we set the color of the previous instruction at the MEM stage to yellow and the current instruction at the EX stage to yellow.

6.9 Branch Prediction (implemented in methods HandleArithmeticOperations, HandleImmediateOperations, HandleJROperations, HandleLuiOperations, HandleBranchOperations, HandleLoadOperations etc..)
We implemented branch prediction with the assumption that the branch is not taken.

When an operation executes, it checks that the previous instruction is a branch instruction. If the branch is not taken, the operation proceeds as normal.

If the branch is taken it is flushed as follows:  in the Abstract_Pipelining_TableColor, we set the color of the current instruction at stages (ID, EX, MEM and WB to purple indication a flushed instruction). We then add a  NOP instruction as a way to simulate handling a mis-prediction.
6.10 Delayed Branch

After any branch operation, we simply add a NOP instruction as a way to simulate the delay of a branch . The NOP instructions populates the table diagonally and is represented in green.
6.11 Dependence Detection

The dependence detection algorithm is handled by the following methods

bool HasDependence(int first, int second); //Checks whether the first instruction and the second instruction have a true dependence.
void SwapInstruction(int instrA, int instrB); //Swaps the instruction instrA  with instrB.
void RearrangeInstructions(); //Rearranges the instr_abstract_table to minimize

bool IsBlockInstruction(QString op); //Returns true if the instruction is a label, a branch or a jump instructions

void Inserting(int first, int second); //Swaps the first and second instruction  and adjusts the  instr_abstract_table
int find_replacement(int first, int second); //Searches for instructions to be used as a separator.

The dependence detection looks for instructions to swap for every block.

We define a block to be any set of instruction delimited by a jump, branch or label instruction.  For example,

Add $3 $4 $5

Sub $1 $3 $2

Lw $8 3($12)

Label1:                  ------( end of Block 1
Mult $3 $6 $4
Add $7 $7 $1
Beq $2 $2 out       ------( end of Block 2

PROCESS:

The dependence detection algorithm operates in each block so as to maintain code consistency. In each block, the algorithm uses the HasDependence(int first, int second) for each line of instruction to determine whether the instruction needs to be separated by a non-dependent instruction. If the instruction needs to be separated, after the second instruction we search (until we reach a block instruction) for an instruction that we may use as a separator; this is done by the method find_replacement(int first, int second).
An instruction is used as a separator if it does not create any dependence between the first and the second instructions.

If a separator is found, we call the method void Inserting(int first, int second) to rearrange it in the instr_abstract_table.
We repeat the process above for every line of instructions. 

At the end, the instr_abstract_table will be rearranged while  reducing the number of stalling operations.

The picture below illustrates all the data hazard avoidance algorithms:

We entered the instruction

add $3 $4 $5

sub $4 $3 $2

add $8 $8 $1

beq $2 $3 out

lw $4 6($7)

lw sh                        // badly formatted instruction is skipped.

lw $6 3($4)

add $2 $8 $9

The Data Dependence algorithm resulted in the following arrangement.

add $3 $4 $5

add $8 $8 $1

sub $4 $3 $2

beq $2 $3 out

lw $4 6($7)

add $2 $8 $9

lw $6 3($4)
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7. Conclusion

Developing this project has turned out to be very beneficial to us.

It allowed us to thoroughly re-understand the mechanism of pipelining and give us a better idea of how instructions are handled.
One of the problems we ran into through the course of this project dealt with the shared code which we were able to overcome at the end.
While our program may contain some minor flaws, this graphical interface can be used to teach other students of the logic of the 5 stage pipeline.

There is room for improvement for the Data Dependence Algorithm. Students may expand this project by developing a more efficient and smarter way to reorganize instructions. They also simulate branch prediction with the assumption that the branch is always taken.
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Rearranged Instructions Box appears when data dependence is checked.








